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Welcome to the ArcGIS Schematics Designer Tutorial I. 
This first tutorial has been designed to help you understand the ArcGIS® 
Schematics Standard Builder and some of the predefined Schematics 
rules. It details a simple way to quickly generate schematic diagrams from 
any feature selection set or trace result highlighted in a map document. 
The only requirement is that your feature classes must be organized into a 
geometric network.

Introducing the sample database’s content

A summary of the Tutorial I database
When the ArcGIS Schematics tutorials were installed on your computer, 
the C:\arcgis\ArcTutor\Schematics\Schematics folder should have been 
created. This directory contains the ElecDemo geodatabase on which the 
first tutorial is based.
This sample database contains an electrical network and a land base.
• The data describing the electrical network is contained in the 

ElectricNetwork feature dataset. This feature dataset comprises the 
ElectricNetwork_Net geometric network, which is composed of the 
following feature classes: the CapacitorBank, ElectricNetwork_Net_
Junctions, Feeder, OpenPoint, ProtectionDeviceBank, RegulatorBank, 
ServiceLocation, Substation and TransformerBank. These feature 
classes contain all the geometric network feature junctions. The 
PrimaryLine and SecondaryLine feature classes concern the geometric 
network feature edges.

• The LandBase feature dataset contains the County polygon features.

Specifications for the tutorial schematic project
The purpose of this tutorial is to create a diagram type to automatically 
generate schematic diagrams from any feature set highlighted after a trace 
or selection operation in a map containing this geometric network. 
The symbology used to represent the schematic elements in the generated 
diagrams will be similar to that used in the map.
You will also learn how to configure Schematics rules that will be 
executed during your diagram generation to automatically reduce 
some schematic elements contained in your diagram or complete your 
diagram by adding new elements such as containers around some specific 
elements.

Note: In this tutorial, you will use specific functionality and commands 
(Diagram Type Assistant, Import From Feature Layers, and so on.) that 
allow you to quickly configure your schematic project in a minimum 
amount of time. To understand in detail how this functionality operates, 
it is recommended that you continue through the ArcGIS Schematics 
Designer Tutorial II where the less automated Designer functions are 
used.

Introducing the tutorial main steps

In this tutorial, the schematic project conception is organized into four 
exercises:
• The purpose of the first exercise is to create the schematic dataset that 

will contain all the schematic data related to the schematic project 
you will build and to specify some default parameters for the related 
schematic project.

• During the second exercise, you will create the schematic diagram 
type that will be used to generate schematic diagrams on the fly from 
any set of features highlighted in a .mxd document containing the 
ElectricNetwork_Net geometric network data. This diagram type will 
work with the Standard Builder.

• The purpose of the third exercise is to customize the schematic diagram 
display.

• The last exercise concerns the predefined Schematics rules that can be 
automatically executed during the generation of diagrams that work 
with the Standard Builder. You will learn how to specify some rules 
parameters.

Introducing the ArcGIS Schematics Designer Tutorial I
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In this exercise, you will learn to create a new schematic dataset, edit the 
related schematic project parameters within Schematics Designer, and 
specify some predefined default values for main parameters.

Creating a schematic dataset

1. Start ArcCatalog™. 
2. Click the Tools menu and click Extensions. 
3. Check the Schematics check box.
4. Click Close
5. Select C:\arcgis\ArcTutor\Schematics\Designer in the Catalog tree.  
6. Create a new file geodatabase in the Catalog tree and type a new 

name for this geodatabase (“TutorialI_SchematicDatabase”, for 
example). 

Note:  You can also create a new personal geodatabase or use an existing 
ArcSDE® geodatabase.
7. Right-click this geodatabase, point to New, then click Schematic 

Dataset. A new schematic dataset appears in the Catalog tree.
8. Type a new name for this schematic dataset (“TutorialI”, for 

example).
Note: An ArcEditor™ or ArcInfo® license is required for schematic 
dataset creation.

Editing the related schematic project within Designer

1. Right-click the new schematic dataset in the Catalog tree and click 
Edit Project. 
The Schematics Designer application starts, loads the associated 
schematic project parameters in memory, and opens directly in design 
mode. As no diagram type already exists in this new schematic 
dataset, the Diagram Type Assistant automatically opens.

2. Cancel the Diagram Type Assistant for the moment.
Note: “Exercise 1: Creating a schematic dataset and editing the schematic 
project” of the ArcGIS Schematics Designer Tutorial II provides you with 
more details about creating and editing schematic datasets and projects.

Exercise 1: Creating a schematic dataset and defining the main parameters

Setting schematic project default parameters

The Default Node Symbol parameter, available from the General tab is 
used by default to represent schematic nodes when their own Symbol 
parameter (defined for their related node element type) is not set.
To define this default symbol, follow the steps below:
1. Click the Default Node Symbol field.
2. Click the Edit Symbol button  to launch the NgUSymbolEditor 

utility, the Schematics CGM Symbol Editor and Vector Drawing tool.
3. Use the NgUSymbolEditor drawing tools to build your CGM symbol 

as desired and type a name for the current symbol (Click File and 
click Save As).

4. Close NgUSymbolEditor (Click File and click Exit).
The Default Node Symbol field is automatically populated by the name of 
the symbol you have just created.
Parameters defining text effects that will be used by default to display the 
labels when these effects are not defined during the label definition, are 
available from the Schematic Project Effects tab. They are assembled into 
the Text Effects subset of parameters.
5. Click the Effects tab.
6. Click the Text Color field that will define the default color for the 

labels and click the color box that is displayed to launch the Table 
Color Editor.

7. Choose or define a color and click OK.
8. Click the Text Font field that will define the default text font for the 

labels.
9. Click one of the default fonts already defined from the drop-down 

list that appers, or click the ellipsis button displayed on the right to 
open the Font Editor. The Font Editor lists all fonts installed on your 
computer and allows you to choose the font you want.
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Parameters defining the selection style are assembled on the Highlighting 
tab.
Three selection styles are available:
• With the Handle style, a selected schematic element is singled out by 

the display of its bounding box.
• With the Highlight style, a selected element is singled out by specific 

color, width, style, and fill.
• With the Handle And Highlight style, the Handle and Highlight 

selection styles are combined.

When the Highlight or Handle And Highlight style is used, some line, 
fill, and text effects must be set to complete the selection style definition 
and the appearance of links, nodes, and labels when they are selected in a 
schematic view.
10. Click the Selection Style drop-down arrow and choose Handle And 

Highlight.
11. To specify the color for the selected lines, click the Line Color 

parameter, click the color box to launch the Table Color Editor, then 
choose or define the desired color that will be used to highlight lines 
when they are selected.

12.  To define the selected lines’ width, click the Line Width parameter 
and type the desired value.

13. For defining the effects for the selected fills, click Solid from the Fill 
Style drop-down list and define the Fill Color parameter. These fill 
attributes will be used to display the symbol fill of the nodes that are 
selected.

14. To define the effects for the selected labels, click the color box that 
is displayed when clicking the Text Color field. Choose or define the 
color you want from the Table Color Editor that opens.

15. Click OK.
16. Click Save. 

By default, the schematic project definition coherence is checked 
before Schematics saves the project. This causes the Please verify 
dialog box to open before the saving is done. This dialog box sums 
up some points that may have been forgotten during your schematic 
project building such as creating an element type without associating 
it with a diagram type, creating a link element type without 
specifying the OriginNode and ExtremityNode attributes, or creating 

  an element type without specifying its identifier. Note that the Please 
verify dialog box lists warnings with a critical-level mark (red, 
orange, or green traffic light) without preventing the saving. In fact, 
each warning is only informative and your project definition can be 
completely operational even if red warnings display on the dialog 
box.

17. Uncheck the Do not perform this verification when saving anymore 
check box and click Yes.

18. Close Schematics Designer.
Note: The schematic project parameters are more detailed in exercise 2 of 
the ArcGIS Schematics Designer Tutorial II. For more information about 
the parameters available from the Schematic Project General, Effects, and 
Highlighting tabs, please read “Exercise 2: Setting the schematic project’s 
default parameters”.
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Exercise 2: Generating schematic diagrams on the fly

The purpose of this exercise is to create a new schematic diagram type 
that works with the Standard Builder to generate schematic diagrams 
on the fly from any selected feature set or trace result in ArcMap™. 
Creating such a diagram type is easier than creating a diagram type that 
works with the Custom Query Based Builder because there are specific 
commands in Designer that allow you to define it with minimum setup 
work and configuration. The standard way to create such a diagram type 
is organized into the following two steps:
1. Create an ArcMap document containing the geometric network data 

you want to use to generate schematic diagrams, then symbolize this 
data.

2. Create the schematic diagram type that will implement the schematic 
diagrams, and use the Import From Feature Layers command to 
quickly create the schematic element types that will implement the 
schematic diagrams’ content based on the ArcMap document’s Table 
Of Content (TOC).

Starting from an ArcMap document

When working with Schematics, you often have a map, map template, 
or layer file that contains the feature layers that comprise the geometric 
network with which you want to work and generate schematic diagrams. 
The symbology used to represent the feature layers in your ArcMap 
project is often already defined, categories have been created, and you are 
familiar with the representation. ArcGIS Schematics offers the possibility 
of using these layer definitions to quickly create schematic element 
types. This point will be detailed in the next section. The purpose of this 
exercise is to create an ArcMap document based on the ElectricNetwork_
Net geometric network stored in the ElecDemo database.
1. Start ArcMap with a new empty map.
2. Click Add Data and browse to the ElecDemo database that should 

have been installed in C:\arcgis\ArcTutor\Schematics\Schematics.
3. Expand the ElectricNetwork feature dataset, select 

ElectricNetwork_Net, then click Add.
4. Click Add Data again, browse to the ElecDemo database, select 

LandBase, then click Add.
5. Click Selection and click Set Selectable Layers.
6. Click Select All and uncheck the HartGIS.County check box.

7. Close the Set Selectable Layers dialog box.
8. Configure the feature layers as you want. You can define categories 

for some of them if you want.
9. Save your .mxd file.
Below is the configuration of the TutorialI.mxd file that should have been 
installed in C:\arcgis\ArcTutor\Schematics\Schematics:
• A particular symbol has been specified to represent the CapacitorBank, 

ElectricNetwork_Net_Junctions, Feeder, OpenPoint, RegulatorBank, 
ServiceLocation, and Substation feature junctions.

• TransformerBank junctions are categorized according to their 
Placement and PhaseCode couple values.

• ProtectionDeviceBank junctions are categorized according to their 
BankType, Unitcount, and Enabled triplet values.

• SecondaryLine feature edges are categorized according to their  
Placement subtype values.

• PrimaryLine feature edges are categorized according to their Feature 
and Placement couple values.
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Creating a schematic diagram type to generate 
schematic diagrams from a map document

Create a schematic diagram type to generate schematic diagrams on the 
fly after a selection or a trace operation from any selected feature set in 
the .mxd document you have created. 
In this exercise, you will learn how to use the Diagram Type Assistant to 
quickly create and specify such a diagram type.
1. Start ArcCatalog and activate the Schematics extension.
2. Browse to the geodatabase that contains the schematic dataset you 

created in exercise 1.
3. Right-click this schematic dataset and click Edit Project. 

Designer starts and your schematic project opens. 
Since no schematic diagram type already exists in this schematic 
dataset, the Diagram Type Assistant automatically opens.

4. Type a name for the schematic diagram type in the Name text box on 
the Name/Builder tab. For example, type “OnTheFlyDiagrams”.

5. Make sure that Standard Builder is selected in the Schematic Builder 
drop-down list. 
The Name/Builder tab content should now be similar to the 
following:

Next, define the schematic element types that will implement the 
schematic elements contained in the schematic diagrams related to this 
diagram type. As you want to use this diagram type to generate schematic 
diagrams from selected feature sets in the .mxd document you created 
in the previous section, the best way to complete this diagram type 
definition is to use the Import From Feature Layers command. This 
command creates schematic element types related to the feature layers 
displayed in a .mxd document. The rest of this tutorial is based on the 
provided TutorialI.mxd file. Even if your own .mxd file and the TutorialI 
are similar, use the TutorialI.mxd file so the screen shots in the rest of this 
document are consistent with the steps you will be following.
6. Click the Element Type Associations tab.
7. Click the Import From Feature Layers button. 

The Import From Feature Layers dialog box opens.
8. At the right of the Map or Layer File field, click the ellipsis button, 

browse to the TutorialI.mxd file installed in C:\arcgis\ArcTutor\
Schematics\Schematics\, select it, then click Add. 

9. All feature layers contained in this .mxd document should 
be displayed in the Select the feature layers to import area. 
The 11 feature layers that comprise the ElectricNetwork_Net 
geometric network should be out of line to the right of the first 
ElectricNetwork_Net entry. The HartGIS.County feature layer that is 
not included in the geometric network appears in the list at the same 
level of the geometric network entry. The check boxes corresponding 
to the ElectricNetwork_Net feature layers should all be checked by 
default. Keep them checked.

10. Check the HartGIS.County check box.
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11. Click OK. 
The Import From Feature Layers dialog box closes. The Element 
Type Associations tab appears as follows:

12. Click OK to close the Diagram Type Assistant dialog box.
In this example, after the complete import, the OnTheFlyDiagrams new 
diagram type appears under the Diagram Types entry in the Designer tree.

The Associated Element Types tab related to this diagram type contains 
all the element types that have been created during the import process and 
that correspond to the feature layers you checked. 
If you expand the Element Types entry, you will find that an element 
type related to the CapacitorBank, ElectricNetwork_Net_Junctions, 
Feeder, OpenPoint, RegulatorBank, ServiceLocation, Substation, 
TransformerBank, ProtectionDeviceBank, PrimaryLine, and 
SecondaryLine geometric network feature layers and to the HartGIS 
County feature layer have been created.

A symbol has been created to display each schematic node in 
the same way as in the ArcMap document. When checking the 
ProtectionDeviceBank and TransformerBank node element types, you 
can note that an attribute and a property have been created to display each 
related schematic node according to database field values in the same way 
as their associated junctions are categorized in ArcMap.
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When expanding the PrimaryLine and SecondaryLine element type 
entries, you can also see that an attribute and a property have been created 
to display the related schematic links according to database field values as 
they are in the .mxd file.

13. Click Save.
All schematic components required to generate a schematic diagram from 
a selected feature set or trace operation highlighted in the TutorialI.mxd 
document are now available. You can test how this new diagram type 
works.
14. Close Designer.

15. Start ArcMap and activate the Schematics extension.
16. Activate the Schematic, Schematic Editor, Schematic Network 

Analyst and Utility Network Analyst toolbars.
17. Load the TutorialI.mxd file.
18. Make sure the HartGIS.County layer is not selectable.
19. Click the Select Features tool and create a selection set of features in 

your map.

20. Click the Generate New Schematic Diagram command. The New 
Schematic Diagram dialog box opens.

21. Click the browse button next to the Schematic Dataset or Folder 
drop-down list to select the TutorialI schematic dataset in the 
TutorialI_SchematicDatabase geodatabase.

22. Click the Diagram type drop-down arrow, click OnTheFlyDiagrams.
23. In the Schematic Diagram Name text box, type a name for the 

schematic diagram that will be generated (Selection1, for example).
24. By default, the Selection Set In Data Frame option is checked in the 

Input From area.



8

25. Click OK.
The new schematic diagram is generated. At the end of the generation 
process, a new schematic diagram containing the schematic elements 
associated with the selected set of features is displayed. The symbology 
used to represent the schematic elements should be similar to the 
symbology used to represent the associated features in the map.

26.  Reactivate your map data frame and use the Utility Network Analyst 
toolbar to create a trace result.

Below is a sample trace result obtained with the Find Connected trace 
task:

27. Click the Generate New Schematic Diagram command.
28. On the New Schematic Diagram dialog box that opens, make sure 

that the TutorialI schematic dataset is currently selected in the 
Schematic Dataset or Folder drop-down list .

29. Click the Diagram type drop-down arrow, click OnTheFlyDiagrams.
30. Type a name for the schematic diagram that will be generated 

(“Trace1”, for example) in the Schematic Diagram Name text box .
31. By default, the Tracing Result option is checked in the Input From 

area.
32. Click OK.
At the end of the generation process, a new schematic diagram containing 
the schematic elements associated with the set of features currently 
highlighted in the map is displayed.
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33. Click Analysis on the Utility Network Analyst toolbar and click Clear 
Results. Repeat this operation to clear the flags and barriers you have 
specified.
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Exercise 3: Customizing the schematic diagrams display

The purpose of this exercise is to learn how the generated schematic 
diagrams display can be customized.
• In the first section, you will learn how vertices that are displayed 

along the edges in the map can also be reported and displayed on the 
associated schematic link.

• In the second section, you will work with schematic attributes and 
properties to customize your schematic elements display by:

 - Adding and displaying labels on Feeder nodes,
 - Changing the ServiceLocation nodes’ default symbol,
 - Creating a new script attribute to regroup values related to  
 TransformerBank schematic nodes and using this attribute to  
 display them.

Displaying vertices along links

1. Close ArcMap and edit your schematic project with Designer.
2. Click the OnTheFlyDiagrams entry under the Diagram Types main 

entry in the Designer tree and click the Schematic Builder field on 
the General tab. Click the ellipsis button that is displayed on the 
right. The Standard Builder Property Page tab is displayed.

3. Check the Initialize links vertices check box.

4. Click OK.
5. Click Save and close Designer.

Note that for all schematic diagrams you have previously generated, if 
you reopen them, they display without vertices along links. To display 
vertices along these diagrams’ links, you need to update the schematic 
diagram content.

7. Click Open Schematic Diagrams, browse to your schematic dataset, 
then choose one of the diagrams you generated previously.

8. Click the Schematic menu and click Update Diagram. The Update 
Diagram dialog box opens.

9. Make sure the Initial features option is selected and click OK. 
After the diagram updates, vertices are displayed along the links.

6. Start ArcMap and open the TutorialI.mxd file. Select a set of features 
in the map and use the Generate Schematic Diagram command to 
generate the new OnTheFlyDiagrams schematic diagram from the 
current selection set.

A new schematic diagram opens. Schematic links contained in this 
diagram are now displayed with their vertices.
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Creating properties and attributes

Attributes and properties can be created to document and symbolize the 
content of schematic diagrams that work with the Standard Builder.
In this section, you will display the circuit description of the feeders 
at the top of each Feeder node and animate the ServiceLocation nodes 
according to the value of the OnWhat database field related to the 
associated feature junction.
1. Edit your schematic project with Designer.
Labeling the Feeder nodes
Before creating the textual property that will be used to display the labels 
at the top of the Feeder nodes, you must create the attribute that will 
return the Feeder CIRCUITDESC field values.
Schematic elements contained in diagrams generated by the Standard 
Builder are managed in differently from those managed by the Custom 
Query Based Builder. During each schematic diagram generation, the 
Standard Builder proceeds in two steps.
• First, it analyzes the highlighted features in the ArcMap document, 

decodes the topology related to these features from the geometric 
network, builds all associated schematic nodes and links, and pulls 
these elements into specific schematic tables it has created in the 
schematic dataset.

• Second, by querying the set of elements stored in the schematic tables, 
the generated diagram opens.

For the element types managed by the Standard Builder, two specific 
types of attributes can be created:
• The dynamic attribute retrieves field values directly from the feature 

class or table with which the schematic element type is associated.
• The static attribute imports field values from the feature class or table 

with which the schematic element type is associated into the schematic 
dataset during the diagram generation process.

Note that if you create a static attribute and use it to document or 
animate your schematic elements, you will have to update any 
previously generated diagrams so the attribute values can be pulled into 
the schematic database and the elements displayed according to these 
values. With a dynamic attribute, the impact on the schematic element 
representation is automatic.

10. Close ArcMap without saving the .mxd file.
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In this example, you are going to create a dynamic attribute related to the 
CIRCUITDESC field stored in the Feeder feature class:
2. Right-click the Feeder element type entry that corresponds to the 

Feeder feature layer created during the import process.
3. Click Create Attribute. The Create Element Type Attribute dialog box 

opens.
4. Type a name for the attribute (“Label”, for example).
5. Click the Type drop-down arrow and click Dynamic Attribute. 

6. Click OK. 
The Attribute Editor dialog box opens.

7. Click CIRCUITDESC in the Feature Class/Table Fields list and click 
the right arrow to validate this field.

8. Click OK. 
The newly created attribute is displayed as follows:

Next, you have to create the textual property that will be used to display 
this label.

9. Right-click the Feeder element type entry in the Designer tree and 
click Create Property. The Create Property dialog box opens.

10. Type a name for the property (“DisplayLabel”, for example) and 
keep the Textual option and the default String Value Type.

11. Click OK.
12. Click the attribute you have just created in the Attribute Name drop-

down list on  the newly created property’s General tab.
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You must now specify how the labels will be displayed on each feeder 
node’s symbol. Labels on nodes are usually placed according to the 
reference point of the symbol used to represent these nodes. This 
reference point is the center of the symbol. In this example, you will learn 
how to create label ports that will be used to attach your labels.

13. Click the Feeder element type entry in the Designer tree, click the 
Symbol Name field on the General tab, then, click the Edit Symbol 
button  that opens the vector drawing tool (NgUSymbolEditor).

14. Click Fit All from the Edit menu and use the Zoom Out and Zoom In 
tool to fit on top of the symbol.

15. Click Insert, point to Port, and click Label Port.

16. Click the top of the symbol to place a label port.
17. If needed, zoom to this location to check the label port position and 

reposition it if you want.

18. Click Save and close NgUSymbolEditor.
You can specify that you want your label to be attached to these label 
ports.
19. Click the DisplayLabel textual property you previously created and 

click the Effects tab.
20. Choose Bottom Center for the Text Alignment parameter; this will 

cause the label to be automatically centered at the top of the label 
port (in other words, the port will be bottom centered regarding to the 
label to which it will be attached).

21. Type “1” for the Label Port parameter.

22. Click Save, click Close, then exit Designer.
23. Start ArcMap and load the TutorialI.mxd file.
24. Activate your map data, right-click the Feeder feature layer, then 

point to Selection and click Select All.
25. Click Selection and click Zoom To Selected Features.
26. Use the Select Features tool to redefine a selection set containing 

the already-selected Feeder junctions and some of their neighbor 
features.

27. Use the Generate Schematic Diagram command to generate the new 
OnTheFlyDiagrams schematic diagram from the current selection 
set. 
A new schematic diagram opens. 
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Symbolizing the ServiceLocation schematic nodes
In this example, you are going to create a discrete property that will 
be used to categorize the ServiceLocation nodes according to the 
OnWhat database field values. There are seven possible values for this 
field: Building, Cabinet, Other, Pole_Cons, Pole_Prim, Pole_Sec, and 
Temp. You will focus on the Building service location only; that is, you 
will represent the ServiceLocation schematic nodes with a particular 
symbol only when these elements are associated with a ServiceLocation 
feature junction for which the OnWhat field value is Building. For the 
other ServiceLocation nodes, the symbol used to represent them in the 
schematic diagrams will be similar to that used in the map to represent the 
associated ServiceLocation feature junction. 
You will create a dynamic attribute related to the OnWhat field stored in 
the ServiceLocation feature class:
1. Edit your TutorialI schematic project within Designer.
2. Right-click the ServiceLocation element type entry in the Designer 

tree and point to Create Attribute. The Create Element Type Attribute 
dialog box opens.

3. Type a name for the attribute (“What”, for example), click Dynamic 
Attribute from the Type drop-down list, and click OK.

4. In the Attribute Editor dialog box that opens, double-click OnWhat 
from the Feature Class/Table Fields list and click OK.

The newly created attribute display as following:

28. If needed, use the Increase/Decrease Symbol Sizes and Increase/
Decrease Text Sizes buttons to adapt your elements’ sizes.

After having zoomed in on the Feeder schematic elements in this newly 
generated diagram, your result will be similar to the following:

29. Close ArcMap without saving the diagram layout or the .mxd file.
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Create the discrete property that will be used to categorize the 
ServiceLocation nodes according to these attribute values:
5. Right-click the ServiceLocation element type entry in the Designer 

tree and click Create Property. The Create Property dialog box opens.
6. Type a name for the property (“DisplayOnWhat”, for example), 

check the Discrete option, and keep the default String Value Type.
7. Click OK.
8. Click the attribute you have just created in the Attribute Name drop-

down list on the newly created property’s General tab.

Next, you need to create the discrete filter that will be used to filter out 
the ServiceLocation whose related OnWhat field value is Building.
9. Click Add Filter. The Add Discrete Filter dialog box opens.
10. Type a name for the filter in the Name text area (“Building” in this 

example).
11. Type “Building” in the Value text box, and click OK.

The new Filters tab is displayed among the discrete property’s tabs with a 
single item related to the Building filter.
12. Select this item and click the ellipsis button that appears at the end.

The Filter Effects dialog box opens. Specify the parameters you want to 
customize for the symbol used to represent the schematic nodes that will 
verify this filter. 
In this example, the default symbol has been changed (to the 
FDIAMONV CGM symbol), the symbol color has been modified, and a 
specific angle has been set.
Note: When the CGM symbol used to represent the element type uses a 
specific font character, modifying the parameter of the symbol consists of 
modifying the Text parameters available from the Text Effects section on 
the Effects tab.
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13. Close the Filter Effects dialog box.
14. Click Save, click Close, then exit Designer.
15. Start ArcMap and load the TutorialI.mxd file.
16. Click Open Schematic Diagrams and open one of the diagrams you 

have previously generated. 
If this diagram contains ServiceLocation schematic nodes, the 
symbol representing these nodes should now be different for the 
Building ServiceLocation nodes.

Note: If the new symbol used to display the Building ServiceLocation 
nodes is too small/big compared to the others’ node elements, you can 
specify the Scaling parameter using Designer. This parameter is on the 
Others tab of the Filter Effects dialog box that opens by clicking the 
ellipsis button that is displayed at the end of the Building filter. For 
example, if you use the FDIAMONV CGM symbol, specify 6 for the 
Scaling parameter so all the nodes in your diagram have a very near scale.
Note: If instead of creating a dynamic attribute related to the OnWhat 
database field you had created a static attribute, you would have to update 
your generated diagrams so the new property effects would be reflected in 
these diagrams.
17. Close ArcMap without saving your diagram and .mxd file.

Creating a script attribute to regroup property discrete filters
In this example, at the beginning of exercise 2, the TransformerBank 
features symbology had been customized to be represented according to 
the Placement and Phasecode values. Groups of values had been defined 
as follows:

Because Schematics discrete filters cannot be associated with several 
values, when the associated element type was created in the schematic 
dataset using the Import Feature Layers function and the discrete 
properties was automatically created to be coherent with the features 
symbology, these regroupments were lost. Each value constituting a 
group has been expanded into several filters, each being represented by 
the same symbology.
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In this section, you will learn how these filters can be regrouped by 
creating a new script attribute and associating this attribute with the 
existing discrete property.
1. Edit your TutorialI schematic project within Designer.
2. Right-click the TransformerBank element type entry in the Designer 

tree and point to Create Attribute. The Create Element Type Attribute 
dialog box opens.

3. Type a name for the attribute (“Placement_PhaseCode”, for 
example), click Script Attribute from the Type drop-down list, then 
click OK.

4. Click the ellipsis button that is displayed at the end of the Script field 
on the General tab related to the newly created attribute.

5. The Script dialog box opens. Type the VB script code that will 
convert and regroup the desired values. In this case, the regroupment 
will operate on the Feature_Placement_PHASECODE_Static 
attribute values which already contain these initial values. In the 
map, the categories are defined as follows:

The VB script will be used to operate the exact same regroupments.
6. Type the following VB script code on the Script dialogbox:

7. Click OK.
8. As the Feature_Placement_PHASECODE_Static attribute is used as 

a parameter in the script, click Add Parameter, click the Parameter 
Name drop down arrow, then select this attribute.

The attribute script definition is complete. You must now change the 
ArcGIS Symbology discrete property currently asssociated with the 
Feature_Placement_PHASECODE_Static attribute so it works with this 
new Placement_PhaseCode attribute script.

When generating a diagram based on several TransformerBank features 
related to a shared category in the map, the associated schematic elements 
might be dispatched in several schematic filters, and several entries with 
the same symbology might be displayed in the diagram legend.
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10. Click the Filters tab, click the first discrete filter parameter line 
related to the 1-129 value, then click the ellipsis button that is 
displayed to edit the parameters. 
The Filter Effects dialog box opens.

According to the script code specified for the new Placement_PhaseCode 
attribute, the 1-129 filter value now corresponds to the  
Underground, 1 Phase value:
11. Change the Name, Value, and Legend Notes parameter values into 

Underground, 1 Phase as shown in the following screen shot.

12. Click Close.
Since schematic elements related to the previous  1-130 and 1-132 
discrete filters will be managed by the Underground, 1 Phase filter, these 
filters can be removed:
13. Select the discrete filter parameter related to the 1-130 value, and 

click Delete Filter. Repeat this operation for the next 1-132 filter.
14. Repeat steps 10 to 12 to change the 1-135 discrete filter into 

Underground, 3 Phases.
15. Repeat the same steps for the 0-128 discrete filter that must become 

Overhead, 1 Phase.
16. Remove the 0-129, 0-130, and 0-132 discrete filters that will be 

managed by the Overhead, 1 Phase filter.
17. Repeat steps 10 to 11 again to change the 0-131 discrete filter into 

Overhead, 2 Phases.
18. Because they will be managed by this Overhead, 2 Phases filter, 

remove the 0-133 and 0-134 discrete filters.
19. Edit the last 0-135 discrete filter parameters and change its Name, 

Value, and Legend Notes parameter values into Overhead, 3 Phases.  
Close the Filter Effects dialog box.

The ArcGIS Symbology discrete property Filters’ tab appears as follows:

9. Start by changing the property-attribute association. Click the 
ArcGIS Symbology property that displays under the TransfomerBank 
entry in the Designer tree, and choose Placement_PhaseCode from 
the Attribute Name drop-down list.
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20. Click Save, click Close, then exit Designer.
21. Start ArcMap and load the TutorialI.mxd file.
22. Click Open Schematic Diagrams and open one of the diagrams you 

have previously generated. If this diagram contains TransformerBank 
schematic nodes, these nodes should be now grouped into the new 
discrete filters.

Figures 1 and 2 clearly show the impact of these changes in the legend. 
Figure 1 shows a diagram sample while the original ArcGIS Symbology 
discrete property was activated. Figure 2 shows the same diagram after 
that property has been redefined and associated with the new 
Placement-PhaseCode script attribute. The four legend entries with the 
same blue symbol that appeared in the TOC before the changes (figure 1) 
are now all regrouped under a unique legend entry (figure 2).

 Figure 1: Before ArcGIS Symbology redefinition

 Figure 2: After ArcGIS Symbology redefinition
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Exercise 4: Specifying schematic rules

In this exercise, you will learn about schematic rules. Predefined 
schematic rules can be used to simplify diagrams (reduction rules) or 
create new elements, such as containers that are related to the elements in 
these diagrams (relationship rules). 
Predefined rules provided with ArcGIS Schematics 9.3 only work with 
diagrams managed by the Standard or Network Analyst builder.  Rules 
specified for these diagram types are executed during schematic diagram 
generations. 
In the following sections, you will learn about four rules: Node Reduction 
By Priority, Relationship, Spatial Query, and Expand Link rules.
• The Node Reduction By Priority rule allows you to generate schematic 

diagrams after all nodes or some particular nodes related to a given 
schematic element type have been removed and after the links that 
connected these removed nodes have been reconnected on a given 
target node so the topology is preserved.

• The Relationship rule allows you to create schematic elements and 
relations regarding the information stored in a relationship class from 
the set of features currently selected in the map.

• The Spatial Query rule allows you to add new schematic elements from 
one or more schematic element classes based on where their associated 
features are located in relation to the features related to another 
schematic element class.

• The Expand Links rule allows you to generate schematic diagrams 
after all links or some particular links related to a given schematic 
element type have been expanded into several links based on specific 
values. These values may be brought by the original links themselves 
or by any other attributes brought by other elements contained in the 
diagram.

Several rules can be specified for your diagrams. They are chained in 
their entry sequence order during each diagram generation process.
• In this exercise, you will first specify parameters for a Spatial Query 

rule that will be used to detect and automatically complete the 
generated schematic diagrams by the secondary network elements that 
are very close to each selected TransformerBank feature.

• Then you will specify relationship rules that will be used to 
automatically add the counties related to the TransformerBank and 
ServiceLocation schematic nodes contained in a diagram and display 

 them as containers around the TransformerBank and ServiceLocation 
in this diagram.

• Next, you will specify parameters for a Node Reduction By Priority 
rule that will be used to simplify your generated diagrams by reducing 
the ElectricNetwork_Net_Junctions elements. Only the junctions with 
one connection (one link) will be kept.

• Finally, you will create an Expand Links rule to expand the Primary 
Lines schematic links according to their PhaseCode field values. The 
Separate Overlapping Links layout automatic triggering will also be 
specified to allow users to clearly visualize that rule effects at the 
diagram loading.

Specifying a Spatial Query rule

At first, generate a sample diagram that will mainly contain 
TransformerBank features connecting SecondaryLine edges without the 
associated SecondaryLine schematic links to be included in the generated 
diagram. After specifying a Spatial Query rule to automatically add 
SecondaryLine links, you will analyze the impact of the rule execution on 
that sample diagram.
1. Start ArcMap and load the TutorialI.mxd file.
2. Zoom in on a part of the map that contains several TransformerBank 

junctions with incident SecondaryLine edges.
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3. Click Selection and click Set Selectable Layers. The Set Selectable 
Layers dialog box opens.

4. Uncheck SecondaryLine and ServiceLocation.
5. Click the Select Features tool and select some PrimaryLine and 

TransformerBank features in the map.

6. Click the Generate New Schematic Diagram command. The New 
Schematic Diagram dialog box opens.

7. Select the TutorialI schematic dataset in the 
TutorialI_SchematicDatabase geodatabase.

8. Click the Diagram Type drop-down arrow and click 
OnTheFlyDiagrams.

9. Type a name for the schematic diagram that will be generated 
(“Selection2”, for example) in the Schematic Diagram Name field, 
and click OK.

The following screen shot shows the sample diagram obtained.

10. Close ArcMap without saving the .mxd file.
You will now edit the schematic project and create a Spatial Query rule 
that will be used to automatically add the secondary network elements 
when these elements are not initially in a diagram.
11. Edit your TutorialI schematic project within Designer.
12. Click the diagram type entry in the Designer tree 

(OnTheFlyDiagrams in this example).
13. Click the Rules tab from the right part of the Designer Editor 

window.
14. Click Add Rule at the bottom right corner of this tab. 

A new empty item appears in the first line on the tab.
15. Click the Name field and choose Spatial Query Rule from the drop-

down list.
16. Click the Description field and click the Ellipsis button that is 

displayed at the end of the rule item. 
The Spatial query rule attributes tab opens.
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In this example, the Spatial Query rule will be used to detect all 
secondary network elements within a distance of 1 meter from any 
TransformerBank and automatically add these elements into the 
generated diagrams. When link elements are added, their origin and 
extremity nodes are also automatically added by the rules, you only need 
to ask for adding the SecondaryLine links.
17. Type a name for this rule in the Description text box (for example, 

“Adding secondary elements near TransformerBank”).
18. Check the SecondaryLine element class check box in the Add the 

schematic elements of the schematic element classes list.
19. Choose ‘are within a distance of’ from the that associated features 

drop-down list.
20. Choose TransformerBank from the ‘one feature associated with a 

schematic element of this schematic element’ drop-down list.
21. Make sure the Apply a buffer to the feature in TransformerBank of 

check box is checked.
22. Type “1” in the text box and choose Meters from the drop-down list.
23. Since you want the rules to simply add the detected elements to the 

generated diagram, make sure that the Add elements to diagram 
check box is checked.

25. Click OK.
26. Save the schematic project definition, close Schematics Designer 

then exit.
You are ready to test the impact of this first rule in the schematic diagram 
generated in step 9.
27. Start ArcMap and load the TutorialI.mxd file.
28. Open the diagram.
29. Click Schematic and point to Update Diagram.
30. Make sure the Initial features option is selected on the Update 

Diagram dialog box that opens and click OK.
Following is the result of the Update diagram command on the sample 
diagram.

24. Check the Keep vertices check box to preserve the vertices along 
links.



23

If you compare this updated diagram with the same diagram before the 
update (see page 21), you can see that (1) SecondaryLine links that are 
very close to TransformerBank nodes initially contained in the diagram 
are now also contained in the diagram, (2) ServiceLocations and 
Electric_NetworkNet_Junctions nodes that often constitute the 
SecondaryLine links’ extremities have been also automatically added in 
the updated diagram.
Here is another sample of a generated diagram from some 
TransformerBank features selected in the map.

The above screen shot shows the set of features selected in the map from 
which the diagram generation starts. The following screen shot shows the 
resulting schematic diagram:
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TransformerBank..
As in the geodatabase, there is a relationship class related to the 
TransformerBank feature class. All the controls on the tab are 
automatically available.
9. Make sure that County_TransformerBank is selected in the 

Relationship class name drop-down list.
10. Make sure that County is specified as the target element class in the 

Select a target drop-down list.
11. Check Add target element(s) to diagram so the counties related to the 

TransformerBank elements as specified in the 
County_TransformerBank relationship class are automatically added 
in the generated diagram.

Next, you have to specify how the relation must be represented in the 
generated diagram. Checking the Relate source and target elements 
check-box causes the schematic source elements to be represented as 
containers around the schematic target elements to which they are related. 
In this example, since it is the County targets you want to be represented 
as containers around the TransformerBank sources, you will have to 
reverse the relation.
12. Check the Relate source and target elements check box.
13. Check the Reverse relation check box.
The Relationship rule attributes tab now appears as follows:

Specifying a Relationship rule

You will now chain this Spatial Query rule execution with a second set 
of rules, Relationship rules, which will be used to add and display county 
elements as containers around the TransformerBank and ServiceLocation 
elements in a schematic diagram.
1. Close ArcMap and edit your TutorialI schematic project within 

Designer.
2. Click the diagram type entry in the Designer tree 

(OnTheFlyDiagrams in this example).
3. Click the Rules tab from the right part of the Designer Editor 

window.
4. Click Add Rule at the bottom right corner of this tab. 

A new empty item appears in the second line of the tab.
5. Click the Name field and choose Relationship Rule from the drop-

down list.
6. Click the Description field and click the ellipsis button that displays 

at the end of the rule item. 
The Relationship rule attributes tab opens.

7. Type a description for this rule in the Description text box (for 
example, “Adding containers related to TransformerBank”)

8. Click the Select a source drop-down arrow and click 
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14. Click OK to close the tab.
15. Click Save.
The symbol used to represent the container elements must be appropriate. 
Generally, using a squared polyline is the best way to graphically 
represent them. In this example, you need to create and specify the 
symbol that will be used to represent the County as containers.
16. Expand the Element Types entry in the Designer tree and choose 

County.
17. Click the Symbol Name field on the related General tab and click the 

Select Symbol button that is displayed.
18. The Symbol Browser opens. Select the ContainerLine symbol and 

click OK.
The following screen shot shows the County General tab content obtained 
after this configuration.

20. Start ArcMap and load the TutorialI.mxd file.
21. Update any diagram you have previously generated. 

It is displayed with one or several containers representing the county 
related to the TransformerBank elements contained in the diagram.

The following screen shot shows the update of the diagram obtained 
from the selected TransformerBank features that were used to exemplify 
the previous rule (see pages 23). Since the TransformerBank elements 
contained in this diagram were related to two counties, two containers are 
now displayed around these TransformerBank elements in the updated 
diagram.

In the ElecDemo geodatabase, there is a second relationship class, 
County_ServiceLocation, that specifies the county related to each 
ServiceLocation feature.
22. Repeat steps 1 to 13 to create a new Relationship rule that will 

relate each ServiceLocation schematic element to its county in the 
generated schematic diagrams.

The following screen shot shows the Relationship rule attributes tab 
content after these steps:

19. Save the schematic project definition and close Schematics Designer.
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Specifying a Node Reduction By Priority rule

In this section, you will specify a Node Reduction By Priority rule that 
will cause the reduction of ElectricNetwork_Net_Junctions elements in 
your generated schematic diagrams. 
Only the ElectricNetwork_Net_Junctions nodes that have one connected 
link will remain; that is, the ElectricNetwork_Net_Junctions node with 
a degree of 1. The target node used to reconnect the incident links of the 
reduced nodes will be determined according to a list of element types in 
order of priority: Substation, Feeder, TransformerBank, ServiceLocation, 
ProtectionDeviceBank, and CapacitorBank.
1. Edit your schematic project within Designer.
2. Click the diagram type entry in the Designer tree and click the Rules 

tab from the right part of the Designer Editor window.
3. Click Add Rule at the bottom right corner of this tab. 

A new, empty item appears in the fourth line of the tab.
4. Click the Name field and choose Node Reduction By Priority from 

the drop-down list.
5. Click the Description field and click the ellipsis button that is 

displayed at the end of the rule item. 
The Node reduction by priority rule attributes tab opens.

6. Type a name for this rule on the Description text box (for example, 
“Reducing NetworkNet Junctions”).

Since the ServiceLocation elements are now related to the County, the 
containers that represent the counties automatically enlarge to incorporate 
the ServiceLocation elements.

23. Click OK to close the tab.
24. Click Save.
25. Test the impact of this new definition in your generated diagrams by 

updating them in ArcMap.
Here is the result obtained in the previous sample diagram:
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11. In the Target node priority options area, click the Substation entry in 
the Element class list ordered by decreasing priorities list and drag 
the entry to the top of the list.

12. Repeat the operation so the Feeder element class is the second 
highest priority class, and so on, for the TransformerBank, 
ServiceLocation, ProtectionDeviceBank, and CapacitorBank element 
classes.

13. Examine the Multiple choices solving area. This area groups 
parameters used to decide whether the reduction will be done when 
there are several nodes of a shared element class candidate to become 
the target. Make sure that the Select the nearest node if conflict 
between two nodes with same priority check box is checked.

14. Uncheck all element classes in the element classes list except 
the Substation, Feeder, TransformerBank, and ServiceLocation 
entries. This means that if an ElectricNetwork_Net_Junctions node 
is selected to reduce and it connects several Substation element 
candidates to be the target node, the rule chooses the nearest 
Substation. The rule will also work in the same way to resolve 
conflicts for the Feeder, TransformerBank and ServiceLocation 
element classes. 
By unchecking the other element classes in the list, you ensure that 
ElectricNetwork_Net_Junctions nodes won’t be reduced if any 
conflicts occur when determining target nodes for elements of the 
other classes. The tab content should is now displayed as follows:

7. Check the Keep vertices check box so the vertices displayed along 
the links are kept after nodes reduction and so a vertex is also 
displayed at the reduced node location.

8. Click the Select node element class to reduce drop-down arrow and 
click ElectricNetwork_Net_Junctions.

9. In the Node connection constraints for reduction area, check 
Connection constraint and uncheck the Reduce nodes with 1 
connection check box so such nodes in the diagram are not reduced 
during the rule execution.

Next you will define how the topology of the network will be preserved 
after the specified node reducing.To accomplish this, you will specify the 
target nodes that will be used to reconnect the incident links related to the 
reduced nodes. By default, the Select the nearest node option is checked; 
that is, the nearest node connecting to the reduced node will become the 
target node. In this example, you will use the Select the highest priority 
node option so the target node depends on the element type of the nodes 
that connect the reduced ElectricNetwork_Net_Junctions node.
10. Check the Select the highest priority node check box.
With this option, for each node connected to the reduced node, the 
reduction rule will analyze the options specified in the Target node 
priority options section before detecting the right target node. The target 
element classes will be ordered from the highest to the lowest priority 
as follows: Substation, Feeder, TransformerBank, ServiceLocation, 
ProtectionDeviceBank, and CapacitorBank.
• Following this order, the Target node will be detected as follows: 

If among all the nodes that connect the reduced node, only one 
node belongs to the element type with the highest priority (that is, 
Substation), this node becomes the target node.

• If among all the nodes that connect the reduced node, no node belongs 
to the element type with the highest priority, the rule will check for a 
connected node belonging to the element type defined with the second-
level priority (that is, Feeder), and so on.

•  If among all the nodes that connect the reduced node, several nodes 
belong to the element type with the highest priority, the rule will detect 
the target node according to the options specified in the Multiple 
choices solving subsection. In this example, you will keep the Select 
the nearest node if conflict between two nodes with same priority 
option checked so the node nearest the reduced node systematically 
becomes the target node when the rule detects several possible target 
nodes.
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15. Click OK.
16. Save the schematic project definition.
You can test the impact of this new rule on one of your generated 
diagrams by updating. Here is the result obtained on the Selection1 
sample diagram (see page 16).

Among the 55 ElectricNetwork_Net_Junction elements in the diagram, 
only 15 of them are kept after the reduction rule execution—those that 
correspond to nodes with only one link connection.

In this last example, you can analyze the diagrams obtained from a set of 
selected features located near the boundaries of three counties in the map.

The following diagram is obtained while all rules are deactivated during 
the generation. It displays only the schematic elements related to each 
selected feature in the map.

If you want to deactivate any rule defined for a schematic diagram type, 
you only need to click its Rules tab and click False in the Active field 
related to the desired rule.
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Note: In this example of configuration, the generation and update 
phases can take several minutes when the diagram is based on many 
TransformerBank features. As the Spatial Query rule execution detects 
the SecondaryLine neighbors of each TransformerBank by working 
directly on the feature class table, more time will be required to execute 
this rule depending on the number of TransformerBank features.

After having activated  all rules on the Rules tab and saved the schematic 
project definition, the resulting updated diagram appears as follows:



30

Generating new diagrams with expanded links

In this section, you will create a new diagram type associated with the 
same element types as the OnTheFlyDiagrams diagram type created in 
exercise 2. This diagram type will be used to generate diagrams in which 
the PrimaryLine edges will be automatically expanded according to the 
PhaseCode value stored in the associated feature class table.
1. Close ArcMap.
2. Edit your TutorialI schematic project within Designer.
3. Right-click the main Diagram Types entry in the Designer tree and 

point to Create. The Create Diagram Type opens.
4. Type a name for your new diagram type (ExpandedDiagrams, for 

example) and click OK. 
The new diagram type entry is displayed in the Designer tree.

5. On the General tab, verify that the specified schematic builder is 
Standard Builder. Click this field and click the ellipsis button that 
is displayed. The Schematic Builder Properties dialog box opens. 
Check Initialize link vertices and click OK.

6. Click the Associated Element Types tab related to the newly created 
diagram type.

7. Right-click the background’s tab and click Edit Associations.
8. The Element Type Associations dialog box opens. Click the Select 

All button at the bottom left corner so all the existing element types  
in the project are associated with this second diagram type and click 
OK. 
The Associated Element Types tab content related to the new diagram 
type now appears as follows:

9. Click Save.
You must now specify the rule that will be used to automatically expand 
the PrimaryLine links contained in diagrams implemented by this new 
diagram type in several links according to the PhaseCode field values 
stored in the associated PrimaryLines feature class.
10. Click the Rules tab from the right part of the Designer Editor 

window.
11. Click Add Rule at the bottom right corner of this tab. 

A new, empty item appears in the fourth line of the tab.
12. Click the Name field and choose Expand Links from the drop-down 

list.
13. Click the Description field and click the ellipsis button at the end of 

the rule item. 
The Expand links rule attributes tab opens.

14. Type a name for this rule in the Description text box (for example, 
“Expanding PrimaryLines by PhaseCode”).

15. Click the Select link element type to expand drop-down arrow and 
click PrimaryLine.

16. You must now specify the values that will determine how the original 
link will be expanded in several links. In this example, the values 
will come from the PHASECODE field. Select PHASECODE in the 
Select field drop-down list in the Select value source area. 



31

 The PHASECODE field value is encoded, so keep the Use code 
name when a field has a code value domain option checked.

17. Next, you have to specify the type of values that will be used to 
expand the links in the Value format area. The encoded values related 
to the PHASECODE field are A, B, C, AB, AC, ABC, and so forth. 
They correspond to a concatenation of characters. Therefore, keep 
the default Concatenation of characters option checked in the Value 
format area.

18. The Target attribute area has to do with how decoded values of 
expanded links are stored in the schematic database. Type a name for 
the new PropertySet attribute you want to be created for that storage 
(“DecodedPhaseCode”, for example). 
The tab content should now appears as follows:

19. Click OK.
20. Expand the PrimaryLine element type entry in the Designer tree. The  

DecodedPhaseCode attribute has been automatically created. The 
value related to each link that will be expanded by that rule will be 
stored in this attribute during the rule execution.

These values can be used to label each expanded link. This can be easily 
done through a textual property.
21. Right-click PrimaryLine in the Designer tree and click Create 

Property. The Create Property dialog box opens.
22. Type a name for the property (“DisplayPhaseCode”, for example). 

Keep the default Textual option, the String value type checked. Click 
OK.

23. Click DecodedPhaseCode from the Attribute Name drop-down list on 
the General tab.

If you try to generate a diagram based on this new diagram type now, 
you will generate a diagram for which all PrimaryLine links whose 
PHASECODE values are ABC, AB, BC, and so on, will be automatically 
expanded but will overlap. For those links to be automatically separated, 
you can specify the Separate Overlapping Links algorithm to be activated 
at the diagram loading. Moreover, to keep the size of your symbols
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appropriate in the generated diagram, it’s better to combine this Separate 
Overlapping Links algorithm execution with the Automatic Scaling 
algorithm using a Composite algorithm. Follow these steps to specify 
such an algorithm execution:
24. Select the entry related to the diagram type in the Designer tree 

(ExpandedDiagrams in this example).
25. Click the Layout Task drop-down arrow on the related General tab, 

and choose Composite.

26. Click the ellipsis button to specify the Composite algorithm 
parameters. The Schematic Algorithm Properties dialog box opens.

27. Click Automatic Scaling in the Select layout task drop-down list and 
click Add.

28. Click Separate Overlapping Links from the same list and click Add.

 Algorithms Properties dialog box appears as follows:

29. Click the ellipsis button while the second algorithm task is selected 
in the Layout tasks list to verify the properties set by default for the 
Separate Overlapping Links algorithm. The related Schematic 

30. Click OK to close the dialog box.
31. Click Save, close Designer, then exit.
Now you can generate a diagram based on this second diagram type 
definition.
32. Start ArcMap and load your .mxd file.
33. Select an area in your map that contains PrimaryLine edges with 

PHASECODE field values equal to ABC, AB, BC, or AC.
34. Click Generate New Schematic Diagram. The New Schematic 

Diagram dialog box opens.
35. Click the browse button next to the Schematic Dataset or Folder 

drop-down list to choose the TutorialI schematic dataset in the 
TutorialI_SchematicDatabase geodatabase.

36. Click ExpandedDiagrams for the second diagram type you have just 
created from the Diagram type drop-down list.

37. Type a name for the schematic diagram that will be generated 
(“ExpandedDiagrams_Selection1”, for example) in the Schematic 
Diagram Name text box.

38. By default, the Selection Set In Data Frame option is checked in the 
Input From area.
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39. Click OK.
The new schematic diagram is generated. All the links related to a 
PHASECODE field values equal to ABC, AB, AC, or BC have been 
expanded, and the Separate Overlapping Links algorithm activated at the 
diagram loading has separated them.
Following is a sample diagram generated from some PrimaryLine 
features selected in the map.


